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Introduction 

 

Introduction 

 

This section provides valuable information about teaching TechnoSales. It 

includes a description of the Teacher Guide, as well as an overview of the 

course. In addition, there are ideas for implementation and technology 

integration.  

 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 
 

How to Use this Guide 

TechnoSales Overview 

Implementation and Technology Integration Ideas 
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How to Use This Guide 

This Teacher Guide contains the following three sections: 

Getting Started – This section contains a course description, as well as ideas for implementation. 

Course Instructions – The course is comprised of six sessions, each focused on a problem-solving 

task that aligns with the project theme. Each session includes assignments that break down the 

task into manageable steps. The components of each session are as follows: 

➢ Overview – An explanation of the session activities and their purpose.

➢ Materials – A list of handouts, sample files, templates, and teacher resource materials

needed to teach the session.

➢ Teaching Strategies – Instructional methods recommended for teaching the activities.

➢ Lesson Plan – A detailed list of each step in the session.

➢ Learning Objectives – A summary of the content knowledge and technical skills taught

throughout the session.

➢ Assignments – A session consists of assignments completed by students. Actions to be

performed on the computer by the student are indicated with a triangle (). Background

information is indicated with a dash (–).

➢ Review – A session review contains a list of fill-in-the-blank, multiple choice, or short-answer

questions intended to review Excel and Word 365 commands, as well as spreadsheet

terminology (answers included).

➢ Skill Review – An additional assignment intended to review spreadsheet skills, or a task

related to a bake sale theme (includes completed sample).

➢ Extension Activity – An additional activity that relates to the skills presented in the session.

Tasks show students how to enhance the document created in the Session with

additional, optional features.

Appendices – This section contains additional information or materials including the following 

resources. 

➢ Assessment Tools – Skill summary and marking sheet for evaluation.

➢ Glossary – A definition of spreadsheet terminology.

➢ Contact Information – How to contact TechnoKids Inc. for curriculum support.
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TechnoSales Overview 

Introduction to TechnoSales 

 

In this course, students plan a bake sale to raise money. This task requires them to investigate food 

preferences and analyze financial data to make decisions about the fundraiser. Findings are 

organized into a report with graphs, to show why their decisions will make the bake sale a success. 

 

Students complete the following tasks: 

 

➢ In session 1, students are introduced to Microsoft Excel and spreadsheet terminology. To 

learn about the program, students play "You Found my X-Cell". This game has students 

identify cell references, navigate in a worksheet, enter data, fill cells with color, format 

the appearance of text, change the alignment, apply borderlines, and select multiple 

cells. It is a fun way to learn essential spreadsheet skills. 

➢ In session 2, students learn how to use Microsoft Excel to make decisions about their 

upcoming bake sale. To make this fundraiser a success it is essential that the dessert sold 

is a popular item. To answer the question "What desserts do students prefer?" students 

conduct a survey. The results are organized into a worksheet and then placed into a 

column graph. The data is then analyzed to determine the dessert item that students 

prefer. Will it be cupcakes, muffins, or cookies? 

➢ In session 3, students continue to analyze the results of the Dessert Preference 

Survey. To answer the question, "Are there differences between desserts girls and 

boys prefer?" a double column graph is used to compare the types of desserts 

both like to eat. This graph will help students to select a bake sale item that 

everyone will enjoy. By studying the graph, they will be able to make a decision 

that will ensure success. 

➢ In session 4, students must decide the flavors of dessert to have at the bake sale. 

This information is important because there needs to be plenty of items that 

people like. To answer the question, "What Flavor of Dessert do Students Like?" 

they conduct another survey. The results are organized into a worksheet and then 

placed into a pie graph. The data is then analyzed to determine the flavor 

students should sell. Will it be chocolate, vanilla, or strawberry? 

➢ In session 5, students calculate the number of desserts required for the sale. This 

information is important because there must be enough items to sell to raise a 

certain amount of money. To answer the question, "How Many Dessert Items Do 

You Need?" past sales are studied. The sales information is organized into a 

worksheet and placed into a line graph. The data is then analyzed to estimate 

the average money earned in previous sales. This information is used to set a 

financial goal. Afterwards, formulas are created to calculate a fair price, amount 

of baked goods needed, and the number of items each student needs to bake. 

By using math to collect information, students can make good decisions that are 

sure to make the bake sale a success! 

➢ In session 6, students produce a report about how to make the bake sale a 

success. Using Microsoft Word, they explain their decisions about the sale. They 

describe the purpose of the sale, the item to be sold, financial goal, price of 

each item, total number of baked goods needed, and the amount each student 

in the class will need to bring to the sale. Afterwards, the report is edited to 

correct spelling and grammar errors. Upon completion, it is sent to the printer for 

publication. 
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Implementation and Technology Integration Ideas 

Have your students learn data analysis techniques and spreadsheet skills in a fun, meaningful 

way. In TechnoSales, students plan a bake sale as a fundraiser. This course is based on a 

problem-solving model, with each session targeting a series of questions or problems to solve. 

The activities connect mathematics to a real-world situation that is simplified to make it 

understandable to children. This course can be used to develop critical thinking, teach inquiry 

and analytic research methods, and build problem solving strategies. There are several ways to 

integrate TechnoSales into curriculum: 

TechnoSales integrates into varied areas of the curriculum: 

• Mathematics Problem Solving Unit: Include TechnoSales as part of your mathematics

curriculum. Engage your students in a problem that they would like to solve – planning a

successful bake sale. The activities in TechnoSales use a problem-solving model. Students

gain an understanding of the problem, investigate the issue, analyze the findings, and

recommend a solution based on the evidence. Throughout the course, various strategies

for formulating a decision are applied to guide students through decision making.

• Mathematics Graphing Unit: Teach graphing techniques in a meaningful way.

TechnoSales includes activities for displaying data in a single and double bar graph, pie

graph, and line graph. By interpreting the graphs students make decisions based on real

world data that they collected. Extension activities have students transform the data

visually by altering the chart type, changing each data point to a picture, and

rearranging a pie graph.

• Digital Literacy Class: TechnoSales can be included as part of a computer course or

class. Students learn spreadsheet skills such as how to manage sheets, format cells,

calculate data, and graph cell ranges. Extension activities develop advanced graphing

skills and a deeper understanding of formulas.

• Computer Science Course: Include TechnoSales as part of a Computer Science course.

The activities target data and analysis concepts. Students collect, organize, and present

survey results and sales information visually using tables and graphs. Spreadsheet skills are

applied to analyze data points and series. The findings are used to predict earnings,

develop a viable plan, and justify recommendations in a report.

• Financial Literacy Unit: Provide an opportunity to learn about money. The scenario of a

bake sale allows students to investigate practical solutions to a realistic problem. Instead

of a teacher-directed approach, have students become actively involved in raising

funds for school events or equipment. Together, they can develop realistic financial

goals and a plan for a successful fundraiser.



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Session 2 
What Desserts Do Students 
Prefer?

In this session, students learn how to use Microsoft Excel to make decisions 

about their upcoming bake sale. To make this fundraiser a success it is 

essential that the dessert sold is a popular item. To answer the question "What 

desserts do students prefer?" students conduct a survey. The results are 

organized into a worksheet and then placed into a column graph. The data is 

then analyzed to determine the dessert item that students prefer. Will it be 

cupcakes, muffins, or cookies? 

Assignment 4: Introduction to Bake Sale Fundraiser 

Assignment 5: Dessert Preference Survey 

Assignment 6: Organize Dessert Survey Results 

Assignment 7: Graph Results of Dessert Preference Survey 

Session 2 Review: Popular Excel Commands 

Session 2 Skill Review: Ice Cream Cart 

Session 2 Extension Activity: Add Pictures into a Bar Graph 
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Session 2 Getting Started 

Overview 

 

In this session, students learn how to use Microsoft Excel to make decisions about their upcoming 

bake sale. To make this fundraiser a success it is essential that the dessert sold is a popular item. 

To answer the question "What desserts do students prefer?" students conduct a survey. The results 

are organized into a worksheet and then placed into a column graph. The data is then 

analyzed to determine the dessert item that students prefer. Will it be cupcakes, muffins, or 

cookies? 
 

Materials 

• Excel 365 

• Excel 365 Flashcards (optional) 

o Home, Insert, Chart Design, Format tabs 

• Bake Sale Workbook sample (optional) 

• Dessert Preference Survey.pdf (optional) 

• Session 2 Review: Popular Excel Commands (optional) 

• Session 2 Skill Review: Ice Cream Chart (optional) 

o Ice Cream Survey sample 

• Session 2 Extension Activity: Add Pictures into a Bar Graph 

 

Teacher Preparation 
(Refer to the Prepare to Teach section of this course for instructions) 

• (Optional) Print the Dessert Preference Survey worksheet or distribute the file to students 

for completion using a PDF annotator. 

• You may wish to view the example file, Bake Sale Workbook. 

• (Optional) Print or gather the Excel 365 flashcards listed in the materials list for this session. 

Download them from the Resource Center in TechnoHub. 

 

Teaching Strategy 
 

In this session, students conduct a survey to learn about the types of desserts people prefer. 

Explain session scenario: 

 

In this session, you need to answer the question "What desserts do students prefer?" To find 

the answer you conduct a survey. This method of problem solving is a good way to learn 

about dessert preferences. The survey results will be organized into a Microsoft Excel 

worksheet and transformed into a bar graph. By studying the data, you will be able to 

determine the most popular dessert item. 
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Assignment 4: Introduction to Bake Sale Fundraiser 

In this assignment, students learn about fundraising and consider their options for raising money 

by having a bake sale. Discuss the following: 

• What is a fundraiser?

A fundraiser is an event or function that is held to raise money for a specific purpose.

• What is a bake sale?

A bake sale is a fundraising activity where baked goods like cookies, cakes, and pies are

sold to raise money for a specific purpose.

• For what purpose are you raising money?

People who attend your fundraiser will want to know the purpose for raising money. Is it

for a class school trip? Is it for the school, to purchase a particular item? Is it for a

community group? Or is it for a national or international organization?

• Why do you think a bake sale will help you raise money?

Students and teachers enjoy eating treats at lunchtime and recess. Selling baked dessert

items is a great way to raise money.

• How can Microsoft Excel help you plan your bake sale?

Microsoft Excel can be used to record, calculate, and graph data. By organizing the

information into a worksheet, it is easy to analyze the data. A table or chart in Microsoft

Excel can help to answer the following questions: What desserts do students prefer? Are

there differences between the desserts girls and boys prefer? What flavor of dessert do

students like? How many dessert items are needed for the bake sale?

Assignment 5: Dessert Preference Survey 

In this assignment, students conduct a survey to learn about students’ dessert preferences. The 

results are organized using Microsoft Excel in the following assignment. Before beginning, explain 

the concept of a survey and demonstrate how to conduct one. 

What is a Survey? 

A survey is a method for gathering information, by asking questions and recording the answers. It 

is a good way to find out the answers to many different questions. For example, a survey can 

help you to learn about: 

• what food kids like to eat the most

• what toys kids like to play with the most

• how kids spend their spare time

• where kids like to play
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Conduct a Sample Survey 

 

Teachers can perform a short exercise with students to help them understand the concept of a 

survey. Give students the following problem: The school council wants to plan a “food day”, but 

they would like to know what food kids like the most. 

 

On the whiteboard, write down three different types of foods that kids enjoy eating. For 

example, pizza, hotdogs, and French fries.  

 

Students can only vote ONCE! Now, have students show, with a raise of hands, how many like to 

eat pizza. The teacher should record the number beside pizza on the whiteboard. Now ask how 

many like hotdogs the best. Record the number beside hotdogs on the whiteboard. Continue 

until each food is complete. 

 

For example: 

 

 Total 

Pizza 13 

Hotdogs 5 

French Fries 7 

 

 

Analyze the Results 

 

Once the list is complete, ask students to analyze the data that was just gathered. Which food is 

liked the best? Which food is liked the least? Based on the results what "food day" should the 

student council plan? 

 

Conduct a Dessert Survey 

 

Once students understand the concept of a survey, they should conduct their own about 

dessert preferences. Results are recorded in the Assignment 5 worksheet. 

 

 

 

Assignment 6: Organize Dessert Survey Results 

 

In this assignment, students follow the instructions to organize the survey results. You may wish to 

introduce the following spreadsheet features: 

 

• Merge and Center: Merge and Center allows the user to combine a group of cells 

together to create one large cell. This is best used when text is too large to fit in one cell, 

such as a worksheet title. 

• AutoSum: AutoSum puts a formula into a cell that tells the program to sum values in a 

group of cells that are above or beside the current cell. It is a fast way to add together 

numbers! 

• AutoFill: AutoFill allows the user to copy the content of one cell to adjoining cells. By 

dragging the fill handle of a cell, the contents of the cell are copied to other cells in the 

same row or column. If a selection contains a number, date, or time, the series can be 

extended using this method. 
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Assignment 7: Graph Results of Dessert Preference Survey 

In this assignment, the survey data is graphed to create a column chart. Students then analyze 

the graph to discover the desserts people like the most and least. Before beginning, explain the 

concept of a graph: 

• What is a Graph?

A graph is a picture created from a set of numbers. Lines or bars usually illustrate graphs.

A graph shows patterns that are harder to recognize by just looking at numbers. Some

kinds of graphs are a line graph, bar graph, and pie chart.

• What is a Column Graph?

A column graph uses vertical bars to show the amount of a number. The higher the

number – the taller the bar; the lower the number – the shorter the bar.

Make a Sample Column Graph 

Teachers can perform a short exercise to help students 

understand the concept of a graph. Give students the 

following problem: The teacher is planning a school trip, but 

she does not know where the students would like to go the 

most.  

On the white board, write down different places to visit, for 

example: museum, science center, farm, play, or library. 

Now have students show with a raise of hands what place 

they like the most. Record the results on the white board. 

Now make a column graph of the results. 

Analyze the Graph 

Once the graph is made, ask students to analyze the data. Where do students want to go the 

most on their school trip? Look at the results. What trip should the teacher plan?  

Compare using numbers or a graph to summarize data. What do you like about using a graph 

to show information? When would you like to use a column graph to show information? 

Graph the Dessert Survey Results 

Once students understand the concept of a graph, they should create their own about dessert 

preferences by following the instructions in Assignment 7. 
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Lesson Plan 

 

Assignment 4: Introduction to Bake Sale Fundraiser 

• What is a fundraiser? 

• What is the purpose of the fundraiser? 

• Why do you think a bake sale will help you raise money? 

• How can Microsoft Excel help you plan the bake sale? 

 

Assignment 5: Dessert Preference Survey 

• Make a list of items that can be sold at a bake sale. 

• Conduct a survey to learn about dessert preferences. Record the results. 

 

Assignment 6: Organize Dessert Survey Results 

• Open Excel 365. 

• Add the worksheet title Dessert Preference Survey and then use Merge and Center to 

combine a group of cells. 

• Enter survey results. 

• Use AutoSum to quickly calculate totals. 

• Use AutoFill to copy a formula into cells. 

• Format the cells to make the information easy to read. 

• Rename the worksheet Dessert Survey. 

• Save the workbook as bake sale. 

• Close Excel 365. 

 

Assignment 7: Graph Results of Dessert Preference Survey 

• Answer questions about graphing. 

• Open the bake sale workbook in Excel 365. 

• Select the data to be graphed. 

• Make a column graph. 

• Apply a chart layout. 

• Label the chart title, x-axis, and y-axis. 

• Delete the legend from the graph. 

• Choose a chart style. 

• Make the graph look great by applying a picture to the plot area and formatting the 

bars and chart title. 

• Resize and position the graph on the worksheet. 

• Analyze the graph. 

• Save changes to the workbook and close Excel 365. 
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Learning Objectives 

Content Knowledge | Data & Analysis: 

• understand the purpose of mathematics in the real world

• use a spreadsheet to solve problems applying a variety of strategies

• collect and organize data using a spreadsheet program

• present collected data visually using a column chart to highlight relationships and

support a claim

• label a graph including the vertical axis and horizontal axis

• interpret data in a graph to develop a solution to a problem

Operating Environment 

• open and close a program

• open a saved workbook

• save a workbook

Spreadsheet Skills | Data Management 

• enter data by typing into the cell or formula bar

• resize the column width

• use AutoSum to calculate the total for each dessert item

• copy a formula into cells using the AutoFill feature

• merge cells together and center the data

• format the font, font size, style, alignment, border, and fill color of cells

• rename a worksheet

• select data range to graph

• insert a column graph

• apply a chart layout

• label the chart title, vertical axis (Y axis), and horizontal axis (X axis)

• remove the legend from the chart area

• apply a chart style

• fill a data point or bar in a column graph with color

• fill the plot area with a picture

• format the text on a chart

• position a chart on a worksheet

• resize a chart

• transform each data point into a picture to visually illustrate the information (optional)

Applied Technology 

• conduct a survey to learn about dessert preferences and then analyze the results

• create a column graph of survey results
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Assignment 4 Introduction to Bake Sale Fundraiser 

A bake sale is a fundraising activity where baked goods such as cookies, pies, and cakes are 

sold to raise money for a specific purpose. 

 

Plan a real or imaginary bake sale. 

 

 

Fundraising Ideas 

school trip library books gym equipment 

team uniform music instruments computer devices 

playground garden graduation ceremony 

 

 

About the Fundraiser 

 

1. What is a fundraiser? 

 An event or function that is held to raise money for a specific purpose. 

  

2. For what purpose are you raising money?  

  

  

3. Why do you think a bake sale will help you raise money? 

  

  

4. How can Microsoft Excel help you plan your bake sale?  
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Assignment 5 Dessert Preference Survey 

To have a bake sale you must decide what baked goods to sell. Survey your classmates to find 

out the type of dessert they would buy at a bake sale.  

The results of the survey will be put into a Microsoft Excel spreadsheet. The information will be 

used later to create a bar graph that will help analyze the results to reach a decision. 

How to Conduct a Survey 

1. Pick Bake Sale Items: To begin the survey, as a class, suggest to your teacher four or five

desserts you would buy at a bake sale. Write the list of items into the table below.

2. Conduct a Class Survey: Ask how many girls would like to buy the first item in the list.

Record the number of responses in the Girls column beside the item in the table. Then ask

how many boys would buy the same item. Record the number of responses in the Boys

column. Repeat for the remaining items in the list.

Each person can only vote ONCE!

3. Calculate the Totals: When complete, calculate the results of each item by adding the

totals together and recording each amount in the Total column.

Record the Survey Results 

DESSERT NUMBER OF GIRLS NUMBER OF BOYS TOTAL 

Answer Questions About the Survey Results 

1. What dessert is liked the most?

2. What dessert is liked the least?

You will compare boys and girls survey 

data in an upcoming assignment. 
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Assignment 6 Organize Dessert Survey Results 

Organize your survey results using Microsoft Excel. Follow the instructions to: 

• Add a title and center it within a group of cells. 

• Record the survey results. 

• Use AutoSum to quickly calculate totals. 

• Use the AutoFill feature to copy a formula into cells. 

• Format the cells to make the information easy to read. 

• Rename the worksheet Dessert Survey. 

• Save the workbook as bake sale. 

 

 

Open Excel 365 

 

1.  Open Excel 365.  

  Click Blank workbook. 

 
 

 

Add the Title "Dessert Preference Survey" and Then Make It Look Great 

 

2. a. Add a title: 

   In A1, type Dessert Preference Survey. 

 

   Press ENTER. 

   

   

 b. Merge and center the title: 

   Click and drag to select the cells – A1, B1, C1, and D1. 

   In the Home tab, find the Alignment group and click Merge and Center.  
  

The title covers more than three cells. You can use Merge and 

Center to combine cells to make the information fit better. Try it! 
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c. Format the text:

 Select the title.

 Make the title look great using these commands:

Font Bold Underline 

Font Size Italic Font Color 

Record the Survey Results in Microsoft Excel 

3. a. Add headings:

 In A3, type Dessert.

 Press TAB to move to cell B3. Type Girls.

 Move to cell C3, type Boys.

 Move to cell D3, type Total.

3 Dessert Girls Boys Total 

 Press ENTER.

b. Enter survey items:

 In A4, type the first dessert from your survey list. Press ENTER.

 Type the next dessert from your survey list.

 Repeat until each dessert has been added.

c. Enter Girls results:

 In B4, type the number of girls who preferred the first dessert. Press ENTER.

 For each dessert, type the number of girls in the correct cell.

If there is no value, type 0.

d. Enter Boys results:

 In C4, type the number of boys who preferred the first dessert. Press ENTER.

 For each dessert, type the number of boys in the correct cell.

If there is no value, type 0.

Now take your survey results and type them into the worksheet. 

If the text is too wide for the cell, double click in between the 

column headings. This will fit the cell to the text. 
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Total Results for Girls and Boys Using AutoSum 

 

4. a. Use AutoSum to create a formula: 

   Select D4. 

   In the Home tab, find the Editing group and click AutoSum.   Press ENTER. 
 

 
 

 b. Study the formula: 

   Select D4. 

   Look in the Formula Bar to see the formula: 
   

   
= S U M ( B 4 : C 4 )   

 
  All calculations begin with the = 

sign. It tells the program that there 

is a formula in the cell. 

SUM is used for addition. It tells the 

program to add the values in the 

cells together. 

(B4:C4) is the cell range. A colon : 

goes between the start and end 

cell. Brackets ( ) go around the 

cells to be summed. 

 

Use AutoFill to Calculate Remaining Totals 

 

AutoFill completes a series by copying information into a cell. It automatically changes the cell 

references. 

 

5. a. Use AutoFill to copy the formula into the cells below: 

   Select D4. 

   Drag the AutoFill handle down to calculate the dessert Totals.  

 

 
 

 b. What is the formula in each Total cell? Select the cell and then look in the Formula Bar: 

  

=SUM(B4:C4) 

=SUM(B5:C5) 

=SUM(B6:C6) 

=SUM(B7:C7) 
  

Excel automatically selects the two adjacent cells and inserts a 

formula that adds the values from the Girls and Boys columns. 

When you let go, 

the Totals will 

show in the cells. 
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Format the Cells to Make the Data Easy to Understand 

6. a. Apply formatting to make the cells look like a table:

 Fill the headings with color.

 Center the column headings.

 Apply borderlines to outline the cells.

b. Apply your knowledge to make the data look great:

Font Bold Fill Color 

Font Size Font Color Center 

Rename the Worksheet 

You will be adding more information to this workbook. Since it will have more than one 

worksheet, it is a good idea to rename the sheet tab. 

7.  Right click on the Sheet1 tab and select Rename.

 Type Dessert Survey and press ENTER.

Save the Workbook 

8.  Click Save on the Quick Access Toolbar.

 Go to the place where you save your work.

 Name the file bake sale.

 Click Save.

Close Excel 365 

Hints and Tips: 

• Pick a font that is easy to read.

• Make the headings a larger font size.

• Center the values in the cells.
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Assignment 7 Graph Results of Dessert Preference Survey 

In this assignment, you graph the survey results. A graph is a picture of information. A column 

graph uses vertical bars to show numbers. The taller the bar the higher the number. The shorter 

the bar the lower the number. 
 

When you graph your survey results, it will be easy to see how many people like a dessert. The 

dessert liked the most will be the tallest bar and the dessert liked the least will be the shortest bar. 

 

Questions About Graphing 

 

1. What is a bar graph? 

  A graph that uses a bar to represent a number. 

  

2. Why would you want to use a graph? 

  It quickly summarizes data by turning it into a picture. 

  

3. What bar would be higher? The bar that represents the number 3 or the bar that represents 

the number 7? 

  A bar that represents the number 7. 

 

 

Open the Bake Sale Workbook in Excel 365 

 

1.  Go to the place where you save your work. 

  Open the bake sale file. 

 

Select the Data to Graph 

 

To make each bar in the graph show the number of people who liked the dessert, you need to 

select the cells with the dessert names and the total number for each dessert. 
 

2. a. Select the Dessert names in Column A: 

   Click the first dessert item. (A4) 

   Click and drag down to select all the desserts.  

 
  

Select the dessert names. 
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b. Select the Totals for each dessert:

 Press and HOLD the CTRL key.

 Click the first number in the Total column. (D4)

 Click and drag down to select all the totals.

Insert a Column Chart 

3.  Click the Insert tab.

 In the Charts group, choose Insert Column or Bar Chart.

 Select Clustered Column.

 Notice that the Chart Design tab is now active.

Both the dessert 

names and 

totals should be 

selected. 

A chart appears on the 

worksheet and Chart 

Tools are now active on 

the ribbon.  

Chart Tools include the

Design and Format tabs.
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Choose the Chart Layout 

 

4.  Click the Chart Design tab. 

  In the Chart Layouts group, click Quick Layout.  

  Rest the pointer over each layout to display the name. Select Layout 9. 
 

 
 

Label the Graph and Delete the Legend 

 

5. a. Add a chart title: 

   Select the Chart Title. 

   Triple click inside the box to select the text. 

   Type the title Desserts Students Like. 

   

 b. Add the X axis label: 

   Select the Axis Title on the X axis. (It has dessert names above it.) 

   Triple click inside the box to select the text. Type Desserts. 

   

 c. Add the Y axis label: 

   Select the Axis Title on the Y axis. (It has numbers beside it.) 

   Triple click inside the box to select the text. Type Number of Students. 

   

 d. Select the legend box. Press the DELETE key to remove it. 
 

 
  

There are many layouts.  

Layout 9 makes the 

information easy to 

understand. 

A legend color codes data to 

identify data series. This chart 

only has one series – Total - so 

you do not need a legend. 
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Choose the Chart Style 

6.  Click the Chart Design tab.

 In the Chart Styles group, click the More arrow.

 Choose a style.

Add a Picture to the Plot Area 

7.  Select the Plot Area. (The area behind the bars)

 Click the Format tab. In the Shape Styles group, click Shape Fill.

 Choose Picture.

 Select Online Pictures.

 In the Search box, type bake. Press ENTER.

Search Term Suggestions 

bake sale dessert clip art cupcake background dessert illustrations 

cookie border baked goods dessert wallpaper dessert tray 

 Double click on a picture you like.

Plot Area will show as 

the current selection. 

TIP: Make Picture Lighter: 

• From the Format tab

click Format Selection.

• Select Fill & Line. Click FILL.

• Drag the Transparency

slider to the right.
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Format the Parts of the Graph 

 

8. Explore the Chart Tools to format the graph: 

    Can you fill the bars with a color, gradient, or texture? 

    Can you change the color and weight of the outline around the bars? 

    Can you add a shadow, glow, or bevel to the bars? 

    Can you apply a WordArt Style to the chart title? 

      Can you adjust the color, outline, or effects applied to the X axis title? 

 

Position and Resize the Graph on the Worksheet 

 

9.  Move the chart below the survey data.  

  Drag the handles to change the size of the chart.  

 
 

Analyze the Graph 

 

10. Have a look at the results in the graph. What do they mean? 

 a. What dessert was liked the most? 

   

   

   

 b. What dessert was liked the least? 

   

   

 

Save the Changes and Close Excel 365  

 

11.  Click Save on the Quick Access Toolbar.  

  Close Microsoft Excel.  
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Session 2 Review: Popular Excel Commands 

Match the command to its name. 

1. C AutoSum A. 

2. A Fill Color B. 

3. E Merge and Center C. 

4. B Bold D. 

5. F Borders E. 

6. D Center F. 

/6 

Which will do the job? Pick the correct command. 

Thick Outside Borders Shape Outline Quick Layout Align Left 
Insert Column 

or Bar Chart 

7. You want to make a graph.

Insert Column or Bar Chart

8. You want to apply a layout to a chart to set the chart titles and labels.

Quick Layout

9. You want to apply a thick outline around a cell.

Thick Outside Borders

/3 

Select the correct choice. 

10. What action is being done to the cells?

a. Increase the row height.

b. Increase the column width.

c. Delete the contents of the cell in column A and B.

/1 

   TOTAL:     /10 
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Session 2 Skill Review: Ice Cream Chart 

You are the proud new owner of an ice cream cart. To help decide what flavors to have in the 

cart, you surveyed adults and children to find out what they liked.  

 

What flavors of ice cream should you have in the cart? 

 

Use Microsoft Excel to organize the survey results and graph the data. 

 

SURVEY RESULTS 

Ice Cream Flavor Adults Children Total 

vanilla 19 3  

bubble gum 0 8  

butter pecan 12 3  

cookies and cream 3 6  

chocolate 6 12  

mint chocolate chip 3 2  

strawberry 10 4  
 

1. Open Microsoft Excel.  Click Blank workbook. 

  

2. Add a title: 

 a. In A1 type Ice Cream Survey. Press ENTER. 

 b. Select cells A1, B1, C1, and D1.  

 c. Click Merge and Center to combine the cells.  

 d. Change the font size to 12.  

 e. Apply the Bold style.  

  

3. Type the survey headings into each cell: 

 A3 Flavors B3 Adults C3 Children D3 Total   

       

4. Type each Ice Cream Flavor into a cell below the Flavors heading.  

Refer to the table above. 

 

  
  

5. Type the number of Adults and Children that like the flavor. Refer to the table above. 

  

6. Calculate the Totals: 

 a. Use AutoSum to calculate the number of people that like the flavor.  

 b. Use AutoFill to copy the formula into the remaining cells in the Total column.  

  

7. Make the data look great.              

  

If the text is too wide for the cell, double click in between the 

column headings. This will fit the cell to the text. 



Session 2 

Copyright © TechnoKids Inc. 40 TechnoSales | Excel 365 

8. Make a column graph of the total number of people that like each flavor.

a. Select the Flavors (A4:A10) and Totals (D4:D10) using the CTRL key.

b. From the Insert tab, click Insert Column or Bar Chart.

c. Select Clustered Column.

9. Click Quick Layout. Select Layout 9.

10. Label the chart:

a. Type the Chart Title, Ice Cream Flavors People Like.

b. Type the X axis Title, Ice Cream Flavors.

c. Type the Y axis Title, Number of People.

d. Remove the legend.

11. Resize  and move  the graph below the survey data. 

12. Save the document as Ice Cream Survey.

Questions about the Survey Results 

Analyze the data and the graph to answer the questions. 

1. Look at the data. What flavor of ice cream do adults like the most? vanilla 

2. Look at the data. What flavor of ice cream do children like the most? chocolate

3. Look at the data. What flavor of ice cream do adults like least? bubble gum 

4. Look at the data. What flavor of ice cream do children like least? mint chocolate chip

5. Look at the graph. What flavor is liked the most? vanilla 

6. Look at the graph. What flavor is liked the least? mint chocolate chip 

7. If you can fit only five flavors into your cart, what ones will you choose?

8. Why did you choose these flavors?

If you have time, use your skills to make the graph look great! 
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Session 2 Extension Activity: Add Pictures into a Bar Graph 

Fill each bar with a stack of the dessert.  

 

For example, if three people liked cookies, you can stack a picture of three cookies inside the 

bar. This will make your graph even EASIER to understand. Try it! 

 

1. Open the Excel workbook that has the Dessert Survey graph you created in Assignment 7. 

2. Select the first bar: 

 a. Click on the first bar once to select ALL the bars in the data series. 

 b. Click again to select ONLY the bar or data point.  

 

3. Insert a picture of the dessert into the bar: 

 a. Click the Format tab. In the Shape Styles group, click Shape Fill.  

 b. Choose Picture.  

 c. Select Online Pictures.  

 d. In the Search box, type dessert name clip art. Press ENTER. 

 

 e. Double click on a picture you like. 

 

4. Stack the picture: 

 a. Click the Format tab. In the Current Selection group, click Format Selection.  

 

 b. In the Format Data Point pane, select Fill & Line. Click FILL.  

 

 c. Select Stack and Scale with and set the Units/Picture to 1.  

 
  

TIP: There should be handles around ONE bar, not all the bars. 

TIP: Look for a picture that is only ONE item! 

Each "like" is now a 

picture. 
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5. Insert a picture of the dessert item into each remaining bar. Follow these steps:

a. Select each remaining bar or data point.

b. From the Format tab, click Shape Fill.

c. Choose Picture.

d. Select Online Pictures.

e. Search for the dessert name clip art. Insert a picture of ONE item.

f. Stack the picture:

o From the Format tab, click Format Selection.

o In the Format Data Point pane, select Fill & Line. Click FILL.

o Select Stack and Scale with and set the Units/Picture to 1.

6. Optional: Make a copy of your work:

a. Click the File tab. Select Save As.

b. Go to the place where you save your work.

c. Save the file as picture in graph.

7. Close Microsoft Excel.

Simple images often 

look better. 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



Appendices 

Appendices 

Refer to the appendices for additional resources: 

Appendix A: Assessment Tools 

Appendix B: Glossary 

Appendix C: Contact Information 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Bake Sale Marking Sheet 

Report Content and Design 

The purpose of the bake sale fundraiser is clearly explained. 

Information in the report makes sense. 

Additional information about the bake sale adds interest to the report. 

The report has no spelling or grammar errors. 

Report contains the pie and line graphs. 

Graphs are placed to illustrate the information in the report. 

The report layout is well-balanced, and the text is easy to read. 
/7 

Survey Data Analysis 

The dessert selected is the most popular among students. 

The flavor of dessert that students like the most is correctly listed. 

The flavor of dessert that students like the least is correctly listed. 
/3 

Bake Sale Recommendations Based on Calculations 

The financial goal is realistic based on the amount earned from previous sales. 

The price set for each item will help to achieve the goal and is a price customers would pay. 

The number of items needed for the sale will be enough for each customer to buy at least one. 

The number of items needed for the sale will be enough to reach or exceed the financial goal. 

The amount that each person needs to bring will achieve the goal and provide enough items. 
/5 

TOTAL /15 



 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 

 

 

 

 

 

 



Bake Sale Report 

 

TechnoSchool is having a bake sale to raise money for a school trip. This sale 

is going to be a big success! 

 

Cookies are going to be sold at the bake sale. This is because they are most 

popular among the students. 

 

There are going to be many chocolate 

chip and chocolate flavored cookies 

because these are the most liked. 

However, there will only be a few 

gingerbread and oatmeal cookies  

because these flavors are not as 

popular. 

 

The goal is to earn $89 from the bake sale. 

This goal was determined because it is the 

average money earned from past sales. 

 

To reach this goal, each item will be sold 

for $0.50. We plan to have 275 customers 

at the sale. We need to sell 300 items to 

reach or exceed our goal. 

 

We need many cookies. Each person in the class is going to help by bringing 

to the sale one dozen items. 

 

The sale is going to be held at lunch time in the front foyer. 

 

Report written by Molly Comat 



Dessert Girls Boys Total

muffins 0 0 0

cookies 4 6 10

brownies 8 2 10

cupcakes 2 2 4
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Flavors Girls Boys Total

chocolate chip 4 5 9

oatmeal 1 1 2

chocolate 5 3 8

peanut butter 2 1 3

gingerbread 2 0 2

Flavor Preference Survey
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FLAVORS STUDENTS LIKE

chocolate chip oatmeal chocolate peanut butter gingerbread



Sales Total

Sale 1 75.25$     Goal Price Items Needed Customers Price Money Earned Students Total Items Number to Bake

Sale 2 55.75$     88.85$     0.50$       178 275 0.50$       137.50$              24 300 13

Sale 3 105.00$   

Sale 4 125.75$   

Sale 5 82.50$     

Sales Information

Items Needed to Reach Goal Money Earned if Customers Buy One Item Items Each Student Needs to Bake

$75.25 
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$105.00 

$125.75 

$82.50 
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